
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PI Vision – Migrating PI 

ProcessBook Displays 



2 | Pa g e 

 

OSIsoft, LLC 

1600 Alvarado Street 
San Leandro, CA 94577 

 

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted, in any form or by any means, mechanical, photocopying, recording, or otherwise, without 
the prior written permission of OSIsoft, LLC. 

 
OSIsoft, the OSIsoft logo and logotype, Managed PI, OSIsoft Advanced Services, OSIsoft Cloud 
Services, OSIsoft Connected Services, OSIsoft EDS, PI ACE, PI Advanced Computing Engine, PI AF 
SDK, PI API, PI Asset Framework, PI Audit Viewer, PI Builder, PI Cloud Connect, PI Connectors, PI 
Data Archive, PI DataLink, PI DataLink Server, PI Developers Club, PI Integrator for Business 
Analytics, PI Interfaces, PI JDBC Driver, PI Manual Logger, PI Notifications, PI ODBC Driver, PI 
OLEDB Enterprise, PI OLEDB Provider, PI OPC DA Server, PI OPC HDA Server, PI ProcessBook, 
PI SDK, PI Server, PI Square, PI System, PI System Access, PI Vision, PI Visualization Suite, PI 
Web API, PI WebParts, PI Web Services, RLINK and RtReports are all trademarks of OSIsoft, LLC. 

 
All other trademarks or trade names used herein are the property of their respective owners. 

 
U.S. GOVERNMENT RIGHTS 

 
Use, duplication or disclosure by the US Government is subject to restrictions set forth in the OSIsoft, 
LLC license agreement and/or as provided in DFARS 227.7202, DFARS 252.227-7013, FAR 12-212, 
FAR 52.227-19, or their successors, as applicable. 

 

No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by 

any means, mechanical, photocopying, recording or otherwise, without the written permission of OSIsoft, LLC. 



3 | Pa g e  

Table of Contents 

Introduction .......................................................................................................................................... 4 

Approach .............................................................................................................................................. 4 

Why Use the PI ProcessBook to PI Vision Migration Utility? ............................................................ 4 

Scenario: Flynn River Hydro ............................................................................................................... 5 

Exercises .............................................................................................................................................. 6 

Exercise 1: Review Existing PI ProcessBook Displays ..................................................................... 6 

Exercise 2: Analyze and Migrate PI ProcessBook Displays .............................................................. 8 

Exercise 3: Review Migrated PI Vision Displays .............................................................................. 10 

Exercise 4: Complete the PI Vision Displays .................................................................................... 12 

Exercise 5: Migrate Another PI ProcessBook Display ..................................................................... 16 

Install PI Vision 2020 (Optional Content) ......................................................................................... 17 

Introduction .................................................................................................................................... 17 

Pre-Installation Tasks .................................................................................................................... 19 

Prepare the Application Server ......................................................................................................... 20 

Exercise........................................................................................................................................... 23 

Solution ........................................................................................................................................... 23 

Create a Service Account and Set Up Permissions ........................................................................ 24 

Exercise........................................................................................................................................... 25 

Solution ........................................................................................................................................... 25 

The Installation Process .................................................................................................................... 36 

Exercise........................................................................................................................................... 40 

Solution ........................................................................................................................................... 40 

Post-Installation Tasks ...................................................................................................................... 41 

Exercise........................................................................................................................................... 45 

Solution ........................................................................................................................................... 46 

Optional: How Kerberos Delegation works ..................................................................................... 49 

Set up Kerberos Delegation .............................................................................................................. 53 

Exercise........................................................................................................................................... 55 

Solution ........................................................................................................................................... 55 

Enabling Users to Change the Display Language .......................................................................... 59 
 



4 | Pa g e  

Introduction 
This lab is designed for people who already have used PI ProcessBook and PI Vision. Students 

should already be familiar with how to navigate displays in both PI ProcessBook and PI Vision 

and understand how PI ProcessBook and PI Vision are able to leverage AF Templates. 

 

 

Approach 
Specific questions or scenarios will be presented to solve primarily using OSIsoft PI ProcessBook or PI 

Vision as your visualization and analysis tool. In addition, the PI ProcessBook to PI Vision Migration Utility 

will be used. More advanced features of PI Vision will have a strong reliance on AF so you will also need to 

use PI System Explorer (PSE). If you are stuck, ask one of the lab monitors for assistance. 

 

 

Why Use the PI ProcessBook to PI Vision Migration Utility? 
PI ProcessBook is a 25-year-old product that has begun to show its age. PI Vision is our leading 

visualization tool built to leverage the latest PI System capabilities where PI ProcessBook has 

fallen behind. We know it takes a lot of hard work to build out PI ProcessBook displays, and we 

want to help move that work over to our modern visualization tool and take advantage of the 

benefits of PI Vision.  While it may seem like a challenging task, this lab will give you the 

knowledge and practice to be confident in using the PI ProcessBook to PI Vision Migration Utility. 
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Scenario: Flynn River Hydro 
You have been hired as a PI Administrator at Flynn River Hydro and you are tasked with migrating 

their PI ProcessBook displays to PI Vision. Luckily the company has built out AF databases with 

templatized AF Assets that have been used in the PI ProcessBook displays. The AF structure features 

three main levels, Hydro Unit, Generation Unit, and Equipment (Generator/Turbine). 

 

 

 

 
Red – Hydro Unit 

Blue – Generation Unit Green – 

Equipment 

 
You know that this AF structure has been utilized in the PI ProcessBook displays and you would like to keep that 

functionality in the migrated PI Vision displays. 

 
Note: The AF database used in these exercises is a slight modification of the Hydro Plant Monitoring Asset Based PI 

Example Kit available on our learning platform (learning.osisoft.com): 

 

https://learning.osisoft.com/asset-based-af-example-kits/349384 

 

https://learning.osisoft.com/asset-based-af-example-kits/349384
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Exercises 

Exercise 1: Review Existing PI ProcessBook Displays 

Exercise Objectives: 

Examine PI ProcessBook functionality 

 

 
Scenario: 

Your first assignment is to review the existing set of PI ProcessBook displays that the company currently uses 

to make sure the display content is properly migrated into PI Vision. The company has a set of displays which 

are used to monitor Flynn River Hydro plant and equipment, located in C:\ProcessBook\Flynn. The company 

also has a display which IT uses to monitor the health of the PI Data Archive, located in C:\ProcessBook\IT. 

 
 

Part 1: PI Data Archive Monitoring Display Approach: 

 

1. Open the PI_Data_Archive_Monitoring.pdi display located in C:\ProcessBook\IT 

2. Select Visual Basic Editor  and double click on This Display under the C:\ProcessBook\IT\ 
PI_Data_Archive_Monitoring.pdi VBAProject to open the VBA code. What does this code do? 

3. Close the Visual Basic Editor and use the PI_Data_Archive_Monitoring.pdi display to answer the following 
questions 

 
 

Questions: 

1. How many Unflushed Events are currently in the write cache? 

 
 
 

2. What is the Point Count in the Base Subsystem? 

 
 
 

3. What is the approximate peak of the PI Server CPU over the last 20 

minutes? Hint: double-click the PI Server CPU trend to maximize it 
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Part 2: Flynn River Hydro Displays Approach: 

 

1. Open the PG_Flynn_Home.pdi display located in C:\ProcessBook\Flynn 

 

2. Use the navigation buttons to open the other Flynn PI ProcessBook displays 
 

3. Use the Flynn River Hydro displays to answer the following questions 

 

Questions: 

1. What is the current Penstock Flow at plant Flynn II? 

 
 
 

2. Which Generation Unit currently has the highest Power Generated? 

 
 
 

 
3. Which Generator currently has the lowest Oil Level? 

 
 
 

 
4. What is the approximate peak Water pH Intake at GU3 Turbine in the last 8 hours? Approximately when 

did this peak occur? 

Hint: hover over the value to see the summary statistics 
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Exercise 2: Analyze and Migrate PI ProcessBook Displays 

Exercise Objectives: 

Use the PI ProcessBook to PI Vision Migration Utility to migrate PI ProcessBook displays to PI 

Vision Understand the configuration and reporting options available in the Migration Utility 

 
 
 

Scenario: 
 

Now that you have reviewed the PI ProcessBook displays that the client uses, you are ready to 

use the PI ProcessBook to PI Vision Migration Utility to convert these displays to native PI Vision 

displays. You would like to preserve the folder and navigation structure of the existing displays. 

 

Note: The PI ProcessBook to PI Vision Migration Utility User Guide is available on Live Library and as a bookmark in 

Chrome: 

https://livelibrary.osisoft.com/LiveLibrary/web/ui.xql?action=html&resource=publist_home.html&pub_categ 

ory=PI-ProcessBook-to-PI-Vision-Migration-Utility 

 

 

Approach: 

Part 1: Analyze the PI ProcessBook Displays 

 
1. Open the PI ProcessBook to PI Vision Migration Utility 

 

2. Click Add Files and select Folders: 
 

 
 

3. In the Browse for Folder window, select the C:\ProcessBook folder and click OK 
 

4. Select the checkbox next to the ProcessBook folder or Select All in the bottom left to select all folders and 

files 

5. Click Run Analysis and wait for the Analysis completed message Part 2: Review the 

Analysis Results 

6. In the Analysis Results pane, expand the categories that appear to view the extent to which the files can be 

migrated 
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7. Hover over the  icon next to each category to review each category definition 
 

8. Hover over the icons in the Issues column to review each migration limitation 
 

9. The PI_Data_Archive_Monitoring display contains VBA , which is not supported in PI Vision. Click Export 

VBA at the bottom of the Analysis Results pane. 

10. After the Export completed message is displayed, click View Reports and select Open Reports Folder to view 

the associated .vba file in notepad. 

11. In the Reports Folder, open the MigrationAnalysis.csv file to view the migration analysis results in 

detail. 

 
 

12. Click Select All at the bottom of the Analysis Results pane 
 
Note: In order to preserve links between PI ProcessBook displays, they must be migrated in the same operation 

13. Click Migrate to open and complete the Migration Settings window: 
 

a Connect to the PI Vision Server: enter https://pivision/pivision and 
 

click Connect b Destination PI Vision folder: <Home> c  Target 

Display Owner: pischool\student01 

d Display Sharing Access: World 
 

e Select Persist folder structure from migrated items 
 

14. Click OK and wait for the Migration completed message 
 

15. Click View Reports and select Migration Report to view the migration results in detail 
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Exercise 3: Review Migrated PI Vision Displays 

Exercise Objectives: 

Examine PI Vision functionality 

Validate migration configuration options in PI Vision 

 

 
Scenario: 

Now that the PI ProcessBook displays have been migrated to PI Vision, you need to examine the migrated PI Vision 

displays. The users are not very familiar with PI Vision, so you need to be able to demonstrate how the new PI Vision 

displays work. 

 

 
Part 1: PI Data Archive Monitoring Display Approach: 

1. Use the shortcut on the desktop to launch PI Vision using Chrome. 

 
a Alternatively, start Chrome and navigate to https://pivision/pivision 

 

2.   Note the folder structure in the lower left panel. Did the folder structure persist from the 

PI ProcessBook files? Select the IT folder within ProcessBook on the left side panel 

3. Click Edit display settings  in the PI_Data_Archive_Monitoring display to open the Display Settings 

window. Did the migration settings apply to this display? 
 

4. Close the Display Settings window. Click the PI_Data_Archive_Monitoring display to open it and answer the 

questions below 

 
 

Questions: 

1. How many Unflushed Events are currently in the write cache? 

 
 
 

2. What is the Point Count in the Base Subsystem? 

 
 
 

3. What is the approximate peak of the PI Server CPU over the last 20 

minutes? Hint: double-click the PI Server CPU trend to maximize it 



11 | Pa g e  

Part 2: Flynn River Hydro Displays Approach: 

 
1.   Back in the PI Vision homepage, select the Flynn folder within ProcessBook on the left side panel 

 

2. Click Edit display settings  in the PG_Flynn_Home display to open the Display Settings window. Did 

the migration settings apply to this display? 

3. Close the Display Settings window. Click the PG_Flynn_Home display to open it 

 

4. Use the navigation buttons to open the other Flynn PI Vision displays 
 

5. Use these Flynn displays to answer the following questions 

 
 

 
Questions: 

1. What is the current Penstock Flow at plant Flynn II? 

 
 
 

2. Which Generation Unit currently has the highest Power Generated? 

 
 
 

 
3. Which Generator currently has the lowest Oil Level? 

 
 
 

 
4. What is the approximate peak Water pH Intake at GU3 Turbine in the last 8 hours? Approximately when 

did this peak occur? 



 

Exercise 4: Complete the PI Vision Displays 

Exercise Objectives: 

Use AF to create analyses to add to the PI Vision display 

Use PI Vision to edit the migrated PI Vision displays 

 

 
Scenario: 

After examining the newly migrated PI Vision displays, you see that there is some data missing from the 

original PI ProcessBook displays. Specifically, in the PG_Flynn_Plant PI Vision display, there is some calculation 

data missing in the upper left corner. You know from the migration results that there are datasets in the 

original PI ProcessBook display. Since you want to be able to use these calculations in other client tools, you 

will create AF analyses for these calculations. You also need to update the banner of the 
PI_Data_Archive_Monitoring display as it utilizes VBA. Since the timebar in PI Vision shows us the time range 

of the display, you will replace this header with a static header. 

 
 

Approach: 

Part 1: Update the PG_Flynn_Plant display using AF analysis 

1. Open PI System Explorer and select the PG_HydroPlant database 

 
2. Navigate to Library and go to Templates > Element Templates > Hydro 

 

 

 
3. In the Analysis Templates tab, create two new expression analysis templates  with the following 

properties: 

 
Analysis 1: % Power Generated 

Expression: ('Actual Power Generated'/'Total Installed 

Capacity')*100 Output Attribute (Map > New Attribute Template) 

o Save Output History: No 
o Name: % Power Generated 

Scheduling: Event-Triggered 
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Analysis 2: Min/Max Power Generated 

Expression 1: TagMin('Actual Power Generated', '*-1h', 

'*') Output Attribute (Map > New Attribute Template) 

o Save Output History: Yes 

o Name: Min Power Generated 

Expression 2: TagMax('Actual Power Generated', '*-1h', '*') 

Output Attribute (Map > New Attribute Template) 

o Save Output History: Yes 

o Name: Max Power 

Generated Scheduling: Periodic 

Period: 01h 00m 00s 
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4. Check In your changes  
 

5. Go to Elements > Flynn River Hydro 
 

 
 

6.   In the Attributes tab, if you see “PI Point not found” errors for the Min Power Generated and/or 

Max Power Generated attributes, right-click each attribute and select Create or Update PI Point 

 
 
 
 
 
 
 

7. In the Analyses tab, right click the Min/Max Power Generated analysis and backfill the analysis from the 

beginning of today until now 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
8. In PI Vision, open the PG_Flynn_Plant display and add value symbols of the newly created % Power 

Generated, Min Power Generated, and Max Power Generated attributes to replace the missing datasets 

and save your display 
 

Part 2: Update the PI_Data_Archive_Monitoring display 

 

9. In PI Vision, open the PI_Data_Archive_Monitoring display 

 

10. Update the non-working date and time header with a header of your choice (ex. PISRV01 PI Data 

Archive Monitoring) and save your display 
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Bonus: Edit the remaining PI Vision displays 

As a bonus exercise, edit the other migrated PI Vision displays to better format the displays in PI Vision. Some 

suggestions are below, but feel free to make any other adjustments! Be sure to save the displays when finished. 

 
PG_Flynn_Home 

Adjust the 4 links and 3 arrows to be evenly spaced by selecting the symbols and going to  Arrange > Align 

Middle 

PG_Flynn_Plant 

Add the Generating Capacity attribute for the displayed Flynn I or Flynn II plant to the display as a Value symbol 

under the trend 

Format the boxes surrounding Flynn River Hydro Power and Features to have different Border colors 

Adjust the Penstock Opening and Penstock Flow value and text symbols so they are not overlapping 

 

PG_Flynn_GenerationUnit 

Increase the Font Size of the Generator Analysis and Turbine Analysis text symbols to 24 Add the Generation Unit Number 

of Attention Systems attribute for the displayed generation unit to the display as a Value symbol 

 
PG_Flynn_Generator and PG_Flynn_Turbine 

 

 
Format the Oil Level gauge symbol  to show the scale in Format Gauge > Visibility > Scale 

Change the text color of the Last Maintenance and Time Since Maintenance value symbols 
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Exercise 5: Migrate Another PI ProcessBook Display 

Exercise Objectives: 

Complete another migration using the PI ProcessBook to PI Vision Migration Utility 

 

 
Scenario: 

You have presented the migrated PI Vision displays to the other PI users at Flynn River Hydro, 

and they are excited to see the new visualization tool and its new capabilities. An engineer has 

created a ProcessBook display recently and would like to see how it works in PI Vision. 

 
 
 

Approach: 
 

1.   Open the PowerGeneration.pdi file located on the Desktop. Examine this display in PI ProcessBook 

 
2. Use the PI ProcessBook to PI Vision Migration Utility to analyze and migrate the display. This display 

should be located in the Flynn folder in PI Vision. 

3. Review the migrated PowerGeneration display in PI Vision and verify the migration settings 

and symbols have been preserved 

4. Make any adjustments to the display in PI Vision, some suggestions are as follows: 

 
Edit the background and font colors of the display to match the other Flynn displays 

Increase the font size of the Flynn I, Flynn II, and Total text and value symbols 

Add a Home text symbol to the display. Add a navigation link to this symbol to link to the 

PG_Flynn_Home display
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Install PI Vision 2020 (Optional Content) 
 

Introduction 

PI Vision Architecture 

PI Vision is a web-browser based application that enables you to easily retrieve, monitor, and analyze 
process engineering information. 

The main components of a PI Vision installation are: 

 

 

1. Clients are individual PI Vision users accessing PI System data. PI Vision is supported by most 
modern browsers on a wide variety of devices, including tables and phones running iOS or Android 
operating system. 

2. PI Vision IIS Application Server provides the execution environment for PI Vision. The application 
server handles all application operations between users (clients) and PI Data Archive servers, PI 
AF servers and MS SQL Server. 

3. PI Vision SQL Database on MS SQL Server stores user display settings and definitions. Display 
definitions include such data as a display name and display owner, symbols on the display, user 
permissions etc. 

Since version 2020 (3.5.0.0) PI Vision no longer relies on PI Web API and PI Web API Indexed Search, that 
have been replaced by AFSearch, thus PI Web API is no longer part of PI Vision install kit. For more info 
see article PI Web API Search Recommendations. 

 

https://customers.osisoft.com/s/knowledgearticle?knowledgeArticleUrl=000031602
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OSIsoft recommends that PI Vision uses the SAME MS SQL Server that PI AF uses. Otherwise, you can 
either install MS SQL Server on the same computer as PI Vision IIS application server or you can use a 
dedicated MS SQL Server installation. 

OSIsoft strongly recommends that the PI Data Archive server(s) and PI AF server(s) be in the SAME 
DOMAIN as PI Vision IIS Application Server and MS SQL Server hosting the PI Vision SQL Database. 

 
Detailed installation and configuration of PI Vision is described in PI Vision Installation and Administration 
Guide. 
 
PI Vision Data Flow 

Example of a typical data flow that occurs as different architecture elements interact to provide the client 
with PI System data. 

When searching for data in a new display: 

1. When a user performs a search for a data item (asset, attribute, or PI point), the client sends a 
request for that data item to the PI Vision IIS Application Server. The request is relayed to the AF 
SDK which populates the search results retrieved from the PI Data Archive and PI AF Server. 

2. Based on the search results, the user can create a symbol for the data item by dragging it onto the 
display. The symbol on the display does not yet contain any PI System data values. 

3. Symbol creation triggers a request for PI data, which PI Vision IIS Application Server relays to PI 
Data Archive or PI AF. When PI System data returns to the client, the symbols on the display are 
populated with data values. 

4. When a user saves the display, the display definition (display settings) is sent to the MS SQL Server 
and stored in the PI Vision SQL database. 

When opening and existing display: 

1. When a user opens an existing display, the client side sends a request for a display definition to the 
PI Vision IIS Application Server, which is relayed to the MS SQL Server. The MS SQL Server returns 
the display definition from which the client generates a display with symbols. The symbols do not yet 
contain any data values. 

2. Symbol creation triggers a request for PI data, which PI Vision IIS Application Server relays to PI 
Data Archive or PI AF. When PI System data returns to the client, the symbols are populated with 
data values. 

 

  

https://livelibrary.osisoft.com/LiveLibrary/content/en/vision-v4/GUID-2C74747A-FE71-47F7-9C10-496BD745E9ED
https://livelibrary.osisoft.com/LiveLibrary/content/en/vision-v4/GUID-2C74747A-FE71-47F7-9C10-496BD745E9ED
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Pre-Installation Tasks 

Hardware and Software Requirements 

PI Vision IIS Application Server requirements 

The requirements for the software on the machine the PI Vision IIS Application Sever are: 

• Microsoft Windows Server 2012 64-bit and later, incl. Server Core versions 

• Microsoft Information Services (IIS) 8.0 and later 

• Microsoft .NET Framework 4.8 

 

The following table show the recommend hardware sizing based on the number of users (clients) 
connecting to the PI Vision IIS Application Server at the same time: 

# of Users (Clients) 1 to 50 50 to 250 250 to 500 

CPU: # of Cores 4 4 8 

CPU: Speed (GHz)  2 2.5 3 

RAM (GB) 6 12 24 

 

MS SQL Server requirements 

PI Vision requires MS SQL Server 2014 or above. All editions (Express, Standard, Enterprise) are 
supported. 

 

PI System requirements 

• PI Data Archive version 3.4.380 (the first version supporting Windows Integrated Security) and later 

• PI AF version 2018 (2.10) and later 

 

Client requirements 

PI Vision clients need to use web browsers that are HTML5 compatible: 

• Microsoft Internet Explorer 11 

• Microsoft Edge 44 and later 

• Google Chrome 76 and later 

• Mozilla Firefox 69 and later 

• Safari 11 and later 
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Prepare the Application Server 

Video: PI Vision 2020 Installation - Phase 1 - Prepare the Application Server 
 
This video demonstrates the steps to prepare the Application service to complete a fresh install of PI 
Vision 2020. It is divided into the following sections: 

• Check System Requirements 

• Prepare the PI Vision Application Server Computer 

• Prepare SSL Access 

Check System Requirements 

The machine where we will install PI Vision is dedicated to hosting PI Vision. Verify that your machine 
meets the following hardware requirements, based on the number of PI Vision users: 

# of Users 1 to 50 50 to 250 

CPU (Cores) 4 4 

CPU Speed (GHz) 2 2.5 

Memory (GB) 6 12 

 

Please note, you can use the PI Vision Administration website to generate a report that lists the number of 
users who have accessed PI Vision within a specific time range if you are unsure of your user base. 

Verify that your machine meets the following software requirements:  

• Windows Server 2012 64-bit or newer, including Server Core versions 

• Microsoft Internet Information Services (IIS) 8.0, or later 

• Microsoft .NET Framework 4 

• Microsoft SQL Server 2014 (Express, Standard or Enterprise) or later to host the PI Vision 
SQL database 

PI Vision 2020 supports the following versions of PI Data Archive and PI Asset Framework: 

• PI Data Archive version 3.4.380 and later 

• PI AF version 2018 (2.10) or later 

  

https://www.youtube.com/watch?v=ppk3rl8Guxs
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Prepare the PI Vision Application Server Computer 

Now that we have verified that our machine meets all of hardware and software requirements, we need to 
prepare the PI Vision Application Server.  

If you have not already done so, work with your IT team to make sure that you have the required ports 80 
or 443 open for the PI Vision web server.  

If the Web Server is dedicated only to PI Vision application, then it is possible to install it to the Default Web 

Site, but if the Web Server is shared with other web applications, third-party or OSIsoft’s PI Manual Logger 

Web and RtReports Generator, it is recommended to install PI Vision to the dedicated website. 

 

For new website it is necessary to assign bindings and their ports. HTTP 
protocol has default port 80 and HTTPS default port 443. If those ports 
are taken by another website, they cannot be used, and different port 
number must be assigned. Any other number must be specified in URL 
address. 

 

 

 

Download the PI Vision Installation Kit to this machine from the OSIsoft customer portal. If you are not 
using an existing SQL Server installation, you will also need to download the Microsoft SQL Server 
installation kit from the Microsoft website. This video will assume we have already got a working SQL 
Server to use. 

Next, we need to add server roles and features. Before you begin, verify that you are in the local 
administrator group on this machine with the Computer Management application.  

Once you’ve verified that you have the appropriate permissions, launch Microsoft Server Manager and 
click Add roles and features and then click Next. Select the Role-based or feature-based installation 
option for the installation type and then click Next. Select the appropriate server from the Server pool 
and then click Next. 

On the Server Roles page, select the roles appropriate for your operating system.  

Operating system  Roles 

Windows Server 2012 and Windows Server 2012 R2 Application Server and Web Server 

Windows Server 2016 and Windows Server 2019 Web Server 
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For the installation on our machine which is running Windows Server 2016, we have selected the Web 
Server (IIS) option. PI Vision install kit requires Web Server (IIS) role to be installed prior the installation. 
Click Add Features and then click Next. 

It is not necessary to add more features beside the default selection that includes management tools (IIS 
Management Console). PI Vision installation procedure triggers a script that installs all necessary features 
and role services for PI Vision. 

The least minimum role services are listed in PI Vision Installation and Administration Guide in section 
“Prepare the PI Vision application server computer – Add server roles and features” or in OSIsoft Live 
Library. 

  

 

For installing the required and recommended roles and features: 

- On the Features page,  
o open the Windows Process Activation Service and then select the Process Model 

and Configuration APIs options. Click Next and then click Next again. 
- On the Role Services page,  

o under Common HTTP Features make sure that you have everything checked 
except WebDAV Publishing.  

o Under Health and Diagnostics, there are no required settings, but we recommend 
adding HTTP Logging, Logging Tools, Request Monitor, and Tracing.  

o All options under Performance are required.  
o Under Security, Windows Authentication, Request Filtering, and URL Authorization 

are required, but we also recommend selecting IP and Domain Restrictions. We 
recommend using Windows Authentication, but if you need to use Basic 
Authentication, you can select that option.  

o Under Application Development, .NET extensibility 4.5, 4.6, or 4.7 and ASP.NET 
4.5, 4.6, or 4.7 are required. We also recommend selecting ISAPI extensions and 
ISAPI filters.  

o Under Management Tools, IIS Management Console is required and we 
recommend adding IIS Management Scripts and Tools and Management Service 
as well. 

Once you have made all of your selections, click Next. Then, click Install on the Confirmation page. 
Please note, this process will take some time. We have significantly increased the speed during this 
section (of the video). 

If your installation was successful, you will see this note under the progress bar. Click the Close button. 

https://livelibrary.osisoft.com/LiveLibrary/content/en/vision-v3/GUID-62223D5D-CE8A-494B-88A1-6491850F4B54#addHistory=true&filename=GUID-B160D4DA-356D-48F0-90F0-CB7FCAC6E70A.xml&docid=GUID-B160D4DA-356D-48F0-90F0-CB7FCAC6E70A&inner_id=&tid=&query=&scope=&resource=&toc=false&eventType=lcContent.loadDocGUID-B160D4DA-356D-48F0-90F0-CB7FCAC6E70A
https://livelibrary.osisoft.com/LiveLibrary/content/en/vision-v3/GUID-62223D5D-CE8A-494B-88A1-6491850F4B54#addHistory=true&filename=GUID-B160D4DA-356D-48F0-90F0-CB7FCAC6E70A.xml&docid=GUID-B160D4DA-356D-48F0-90F0-CB7FCAC6E70A&inner_id=&tid=&query=&scope=&resource=&toc=false&eventType=lcContent.loadDocGUID-B160D4DA-356D-48F0-90F0-CB7FCAC6E70A
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Prepare SSL Access 

Now that we have prepared the PI Vision Application Server, we need to configure Secure Socket Layer 
(or SSL) access. To fully secure access to PI Vision, use a digital certificate obtained from a trusted third-
party registrar. Though the PI Vision installation can create a self-signed certificate, this certificate will not 
be trusted by browser clients and will result in certificate warnings when users visit PI Vision. 

The Vision Install Kit will set up the site for SSL access, but we’ll need to add our own certificate to 
replace the self-signed certificate after Vision is installed.  

Keep in mind that this walk-through assumes you are installing IIS. That means that we are not running 
any other websites on this machine. Refer to the documentation if you are installing PI Vision on a 
webserver that already has existing websites.  

Exercise 

Test your knowledge by going through the steps for preparing an Application Server for the PI Vision 
installation. You can use the virtual environment provided with this part of the course or perform an 
installation on your own environment. The virtual environment is not identical to the one used in the 
videos. Differences will be pointed out in the exercises. 
 
Tasks: 

- Add the required Server Roles and Features. At this point you can limit this to the Web 

Server (IIS) role which is required prior to the PI Vision installation and continue the 

installation process with the default settings. 

- Within the training environment we will use the self-signed certificate which will be 

generated during the PI Vision installation. For the purpose of this training, it is not 

necessary to obtain a digital certificate from a trusted third-party registrar as it is 

recommended.  

Solution 

Review the video for details. 
 

  



24 | P a g e 
 

Create a Service Account and Set Up Permissions 

Video: PI Vision 2020 Installation - Phase 2 - Create a Service Account and Set Up Permissions 

 

This video demonstrates the steps to verifying the permissions for the service account where you will 
install PI Vision 2020. It is divided into the following sections: 

• Check PI Data Archive & PI AF Server Permissions 

In Phase 2 of the PI Vision 2020 installation process, we need to create a service account and set up 
permissions. We strongly recommend that you create a custom service account for PI Vision. We worked 
with our IT team and they created a service account that we will use for PI Vision.  
 
Check PI Data Archive & PI AF Server Permissions 
 
We need to verify that we have the right permissions on our PI Data Archive and AF Server to allow this 
account to connect to them.  

We have switched to our PI Data Archive machine to make sure that we have the right permissions.  

Launch PI System Management Tools. You can do this from any machine with PI System Management 
Tools installed. 

Click Security and then click Identities, Users, & Groups. Verify the existence your PI Vision identity. 
Click Mappings & Trusts and confirm that this service account is mapped to the PI Vision identity.  

Click Database Security. Verify that the PI Vision identity has read access on PIMapping and PIPoint. 
For individual PI Points, we need to make sure that the PI Vision service account has read access on 
Point and Data Security. We’ll perform a spot check on one of them to confirm that this was setup 
correctly, in this case, we’ll use SINUSOID. 

Click Point Builder. Click Search and then search for SINUSOID. Click SINUSOID from the search 
results and then click the Security tab. Here we can see the PI Vision identity has read access on Point 
Security and Data Security. This will need to be true for any PI Point that's viewed in PI Vision.  

Note: The PI Vision Service account requires read access to all PI Points which should be available to 
view in PI Vision for performing searches and potentially calculations for AF Data References. Still, users 
will only be able to access data via PI Vision to which they have read access personally. 

We need to confirm that we have read access in AF for the service account with PI System Explorer.  

Click File and then click Server Properties. Click the Mappings tab and verify that we have a mapping 
for the PI Vision service account and that it receives an identity that we know has read and read data 
access to the AF Server, the AF Databases, the AF Elements, the AF Tables, and the Event Frames that 
we want to be viewed in PI Vision.  

  

https://www.youtube.com/watch?v=iRzsCxay8mU
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Exercise 

Perform the steps to create a service account and set up permissions on the virtual environment. On the 
virtual environment you will need to create the account first and set the permissions as shown in the 
video. If you are unsure, have a look at the solution for guidance. 
 
Tasks: 

- Create a Service Account for PI Vision on the Domain Controller. OSIsoft recommends 
that you name the service account PIVisionService. Set a password for the account (for 
example: ABC123xyz) and note it down for later use. 

- On the PI Data Archive machine, create a PI Vision identity and map the service account 
to this identity. Give the PI Vision identity read access to the tables PIMAPPING and 
PIPOINT. Since we only have demo Points on the system, we do not need to give read 
access to existing Points, however you can do this for SINUSOID for practice. 

- Create an identity on the Asset Server and map the service account to this identity. We do 
not have any databases yet, so it is sufficient to give read access to the Asset Server in 
general. 

Solution 

Create a Service Account for PI Vision 

1. On the domain controller, open Active Directory Users and Computers. 

2. Right-click the Users folder, and then click New > User top open the New Object - User window. 

3. Enter the name of your account and click Next. 

You can enter Vision as the first name, Service as the last name, and PIVisionService as the user 
logon name. 
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4. Enter the account password ABC123xyz and select User cannot change password and Password 
never expires check boxes. 

Make a note of the account name and password as you will need it during installation. After 
installation, you will configure the PI Vision application pools and services to run under this new 
account. 
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5. Click Next and Finish. 

Check PI Data Archive Permissions (back on PISRV01) 

1. In System Management Tools create a new identity PIVision. 
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2. Create a new mapping to map the PIVisionService account to this new identity. 
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3. Give this identity read access to the PIMAPPING and PIPOINT tables. 
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4. For each PI Point which should be accessible through PI Vision we need to grant read access. On 
the training system we can do this exemplarily for SINUSOID as we do not yet have any 
production points we need to expose. Since we have included the identity with read access on the 
PIPOINT table, the identity will be added with read access to newly created Points by default. 
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Check PI AF Server Permissions 

1. On the training system, we do not yet have any AF databases we need to expose in PI Vision. To 
grant the identity general rights to AF open PI System Explorer and go to File > Server Properties 
> Identities… (or File > Connections…, select the AF server and click Properties) to open the PI 
AF Server Properties dialog. Add a new identity PI Vision Service. 

Note:  A message will display to create a new database, you can respond ‘No’. 
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2. Under the Mappings tab create a new mapping and map the identity to the account 
PISCHOOL\PIVisionService. 
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3. To set the permissions for the new identity open File > Connections… (if you don’t have it 
open already from the previous steps), and open the security settings for the Asset 
Server. 
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4. Add the new identity and give it read access. 
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The Installation Process 

Run the Installation Process 

Video: PI Vision 2020 Installation - Phase 3 - Run the Installation Process 

 

This video demonstrates the steps to install and run PI Vision 2020. It is divided into the following 
sections: 

• Run the PI Vision 2020 Install Kit 

• Check the PI Vision Application Pool Configurations 

• Select a Different Certificate to Use for the PI Vision Web Site   

Run the PI Vison 2020 Install Kit 

Navigate to the location on your computer where you have the PI Vision Install Kit downloaded.  

Remember, before you install PI Vision here, you need to run the installation as an account that is in the 
local administrator's group.  

Right click the install file and then click Run as administrator. Extract the files to a location of your 
choosing. When this process is complete, you will see a list of the components that will be 
installed. Notice that one of the components is Microsoft.NET Framework 4.8. This will likely require a 
restart of the machine. Click OK to continue. When the .NET Framework install is complete, click Finish, 
then click Restart Now to reboot your machine. 

After the machine reboots, the installation process will continue, running services will need to be stop, 
clock Next.  A series of processes contain files that need to be closed, select automatically close 
application and click Next.   (you may be requested to enter the Default Asset server and Default Data 
server in the prompts and click Next. You can specify a custom location for the PIHOME Installation 
directories or keep the default C Drive location.) 

The installation process will continue. Next, we will begin the PI AF Client 2018 SP3 Patch 3 installation. 
Click Next. Decide whether you want to participate in our customer experience improvement program and 
then click Next. You can optionally enable the Management plug-in feature by clicking here. Click Next to 
continue.  

If you do not have Microsoft Excel installed on this machine, you will see a message here to let you know 
that PI Builder will not be installed since Excel is not available. 

Click Install. 

The final part of the install is the PI Vision Installation Wizard. Click Next. Click Continue to 
acknowledge that you will comply with the laws, rules, and regulations for cookies.  The next part of the 
process checks for any missing required Windows features. Leave the Install missing Windows 
features now option checked. Click Continue. In the Install Required Windows Feature pop-up, click 
OK. 

  

https://www.youtube.com/watch?v=WrEvuZiZeVI
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Again, decide whether you want to participate in our customer experience improvement program and then 
click Next. Click Next again. Since we just installed the web server, we only have the default website 
listed here.  

If you had an existing web server, you would select your website here if you were not using the default 
website. Click Next and then click Install. After the process completes, click Finish. Then, after the 
services start, click Next.  Our machine now requires a reboot so we will click Yes to restart the machine 
now.  

Once the machine has been rebooted, you can see that the PI Vision 2020 setup was successful. Click 
Close. Close Server Manager. PI Vision 2020 is now installed. 

Check the PI Vision Application Pool Configurations 

An IIS application pool is a pool - i.e., a collection - that houses applications on IIS. Each application pool 
consists of a process called w3wp.exe that runs on the server machine. 

PI Vision installation creates three application pools: 

• PIVisionAdminAppPool runs the Administration website 

• PIVisionServiceAppPool runs the main PI Vision application website 

• PIVisionUtilityAppPool runs the PI Vision Display Utility. 

 

 

We need to make sure that the PI Vision application pools are running under the correct account in the 
Internet Information Services Manager. In the IIS Manager, Click the webserver and then click 
Applications Pools. Here, we can see the admin, service, and utility application pools. Right click one 
and then click Advanced Settings to change their identity. Scroll to the Identity setting, double click it, 
select Custom account, click Set, enter your username and password, click OK and then click OK again. 
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Verify that Enable 32-Bit Applications is false (default setting). Click OK. Repeat these steps for the 
remaining app pools.  
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When you’re finished, your app pools are running under the custom domain account.  

Select a Different Certificate to Use for the PI Vision Web Site 

Within IIS Manager, click the web server and then click Sites to display the list of web sites on your 
machine's IIS server. Locate the site that has the PI Vision application installed under it. By default, and 
in our case, this is Default Web Site. 
 
Click Bindings. In the Site Bindings dialog box, click the https row and then click Edit. In the Edit Site 
Bindings dialog box, click the drop-down list below SSL certificate and then select a different certificate 
which will be bound to the port selected in this binding for your IIS Website. 
 
The certificate we selected is trusted by browser clients and will prevent certificate warnings from 
occurring when users visit PI Vision. Click OK. 
 
We have now verified that we have the right permissions and certificate and we have successfully 
installed PI Vision on this machine. From here, you will finish configuring PI Vision.  
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Exercise 

 
Perform the steps to run the installation process on the virtual environment.  You will need to make some 
adaptions to the setup at hand compared to the video. If you are unsure, have a look at the solution for 
guidance. 
 
Tasks: 

- Run the PI Vison 2020 Install Kit (PI-Vision_2020_). A shortcut to the folder PI Vision 

Install Kits can be found on the desktop. 

- Optional: Run the install kit for PI Vision 2020 Patch 1 (PI-Vision_2020-Patch-1_) which is 

also available on the training environment. 

- Check the PI Vision Application Pool Configurations 

Note: Within the training environment we will use the self-signed certificate. 

Solution 

Run the PI Vison 2020 Install Kit: 
 
Follow the installation process with the default settings as shown in the video. You might need to re-start 
the installation process manually after reboot. On the virtual environment it is not necessary to enter the 
default servers as they are already set for the machine. 
 
Note: If you have not installed the required and recommended roles and features previously the 
installation of required Windows Features will take several minutes. 
 
Check the PI Vision Application Pool Configurations: 
 
Change the identity for the three application pools to PIVisionService (password: ABC123xyz). 
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Post-Installation Tasks 

Configure PI Vision 
 

Video: PI Vision 2020 Installation - Phase 4 - Configure PI Vision 

 

Introduction 
This video demonstrates the steps to configure PI Vision 2020 after installation. It is divided into the 
following sections: 

1. Add a PI Data Archive Server or a PI AF Server to the Registered Servers List 

2. Manage PI Vision Local User Groups 

3. Check SQL Server Permissions 

4. Create the PI Vision Database 

5. Allow Access to Each PI Data Archive Server and PI AF Server from PI Vision 

6. Configure PI ProcessBook Import Folders 

 
Part 1: Add a PI Data Archive Server or a PI AF Server to the Registered Servers List 
 
Before going to the PI Vision Admin site, there are a couple of things that we want to check. First, we 
want to make sure that the PI Data Archives and AF Servers that we want to connect to in PI Vision are 
listed in our known servers table. 
 
On the PI Vision web server, open PI System Explorer and click File then click Connections, I'm going 
to confirm that I can connect to my Data Archive by selecting the server and clicking Connect. To add 
additional AF servers, click Add Asset Server, enter the name of the AF Server in the Host field, click 
Connect and OK. Similarly, to add PI Data Archives, click Add Data Server, enter the name of the PI 
Data Archive in the Host field, click Connect and OK.  
 
Part 2: Manage PI Vision Local User Groups 
 
Next, there are three local user groups that were created when PI Vision was installed. These groups 
control who has access to different PI Vision components. Open Computer Management, expand Local 
Users and Groups under System Tools, and select Groups. The PI Vision Admins, PI Vision Users 
and PI Vision Utility Users groups were all created when PI Vision was installed.  
 
 

The PI Vision Admins group controls access to the PI Vision Admin site and by default contains 
the user who installed PI Vision.  
The PI Vision Users group controls access to the PI Vision site and by default contains 
authenticated users.  
The PI Vision Utility Users group controls access to use the PI Vision Display Utility, which is 
installed with PI Vision, or the PI ProcessBook to PI Vision Migration Utility, which is a separate 
installation. By default, this group also contains the user who installed PI Vision.  
 

  

https://www.youtube.com/watch?v=QuR6zGgoqdw


42 | P a g e 
 

To add domain users or groups to a PI Vision local group, double click the group, click Add, enter the 
name of the domain user or group account, click Check Names, then click OK and Apply. To remove 
existing users or groups from a PI Vision local group, double click the group, select an existing member, 
click Remove, and Apply. Be sure to update all of these PI Vision local groups with your necessary 
domain users and groups. 
 
Part 3: Check SQL Server Permissions 
 
Next, we will check the SQL permissions before attempting to create the PI Vision SQL Database 
automatically. On the SQL Server, open SQL Server Management Studio and connect to the SQL 
Server instance. Note the SQL Server instance name, which will be needed for the PI Vision Admin site. 
The full name will be located at the top of the Object Explorer pane, and it might end with SQLExpress. 
Next, verify that this SQL Server has Allow Triggers to Fire Others set to true. To check this right click 
the SQL instance and go to Properties. Under Advanced confirm that Allow Triggers to Fire Others 
(under Miscellaneous) is set to true.  
 

 
 
Additionally, the user accessing the PI Vision Admin site must have specific permissions on the SQL 
Server to be able to create the PI Vision SQL database. Expand Security, Logins, right click the user 
account and select Properties. Click Server Roles and confirm that the dbcreator server role is 
selected.  
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ALTER ANY LOGIN permission is also required which is given to users who have the securityadmin 
server role.  
 

 
 
Part 4: Create the PI Vision Database 
 
After verifying that my user account is in the PI Vision Admins group and has the appropriate 
permissions on the SQL Server, we will navigate to the PI Vision Admin site on the PI Vision web server.  
Right-click the web browser and select Run as Administrator. Then enter the PI Vison Admin site URL. 
By default, the PI Vision Admin site will be located at https://webserver/PIVision/Admin where 
webserver is the name of the PI Vision web server. Alternatively, open IIS Manager, expand Sites, the 
site where PI Vision is installed (in my case Default Web Site), PIVision and select Admin. In the 
Actions pane, click Browse *:443 (https). Note that navigating to the PI Vision Admin site via IIS 
Manager will use localhost in the URL, which might not be included in the certificate Subject Alternative 
Name.  
 

PI Vision uses two websites: 

• The administration website used for initial configuration and maintenance: 

o https://<WebServer>/PIVision/Admin 

• The main application website for creating and visualizing displays: 

o https://<WebServer>/PIVision 

<WebServer> is the hostname or FQDN of the PI Vision IIS Application Server where Microsoft 
Internet Information Services (IIS) server role is installed. 

 
 
  



44 | P a g e 
 

In the Overview page of the PI Vision Admin site, click Manage Configuration next to PI Vision 
Database. In the SQL Server field, use the dropdown or manually enter the name of the SQL Server 
instance to host the PI Vision SQL Database which was found in SQL Server Management Studio. In 
the Database field, enter the name of the PI Vision SQL Database to be created on the SQL Server. Click 
Save to create the PI Vision SQL Database and verify green checkmarks appear next to the fields. If you 
are not able to create the PI Vision SQL Database using the PI Vision Admin site, you may create the PI 
Vision SQL Database manually, please see the Run the go.bat script to configure the PI Vision 
database section of the PI Vision Installation and Administration Guide for details. 
 
Part 5: Allow Access to Each PI Data Archive Server and PI AF Server from PI Vision 
 
The next step in the PI Vision Admin site is to add the Data Archives and AF Servers that we want to be 
exposed in PI Vision. In the PI Vision Admin Configuration page, click the Data Servers tab. Here the 
Data Archives from the Known Servers Table on the PI Vision web server are shown. To verify 
connectivity to a Data Archive, click Test Connection and make sure a green check appears in the 
status. Select the Allowed checkbox next to each Data Archive to be used in PI Vision and click Save. 
 
Next, click the Asset Servers tab in the PI Vision Admin Configuration page. To verify connectivity to an 
AF Server, click Test Connection and verify a green check appears in the connection status. Select the 
check box next to each AF Database to be used in PI Vision or select the All check box to allow access to 
all databases for each AF Server. Click Save when finished. 
 
Click Overview to go back to the PI Vision Admin overview page, and verify green checks appear next to 
the PI Vision SQL Database, each Data Archive server, and each AF Server. 
 
Part 6: Configure PI ProcessBook import folders 
 
The last configuration item to set up in the PI Vision Admin site is PI ProcessBook import folders. Click 
Import Folder Management. Here we can set up specific folders and the PI ProcessBook displays that are 
added to that folder will get picked up and be available to view in PI Vision. Make sure the PI Vision 
application pool account has read access to any folder and its subfolders to be added in this page. To add 
a PI ProcessBook import folder, enter the folder path in the Folder field and optionally an alias in the 
Friendly Name field. Click Add. Refresh the page and verify a green check appears in the Folder 
Accessible column. 
 
Conclusion 
 
We have now created the PI Vision SQL Database and managed the PI Vision local groups, in addition to 
configuring Data Archive, AF Server, and PI ProcessBook import folder access using the PI Vision Admin 
site. In the next video, we will configure Kerberos delegation to allow users to access Data Archives and 
AF Servers using Windows Integrated Security. 
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Exercise 

 
Perform the steps to configure PI Vision on the virtual environment.  You will need to make some 
adaptions to the setup at hand compared to the video. If you are unsure, have a look at the solution for 
guidance. 
 
Tasks: 
 

- Manage PI Vision Local User Groups. Add Domain Admins to the group PI Vision Admins 

and Domain Users to the group PI Vision Users. 

- Check SQL Server Permissions 

- Create the PI Vision Database 

- Allow Access to PI Servers from PI Vision 

- Add a PI ProcessBook Import Folder (C:/ProcessBook Displays) 
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Solution 

 
Manage PI Vision Local User Groups 

PI Vision installation creates three local groups on PI Vision IIS Application Server:  

 

 

• PI Vision Admins: Members of this group are granted access to the PI Vision Administration 
website https://<WebServer>/PIVision/Admin. 

➔ Add Domain Admins as shown in the video. 

• PI Vision Users: Members of this group are granted access to the main PI Vision application 
website https://<WebServer>/PIVision. 

➔ Add Domain Users and remove any other users as shown in the video. 

• PI Vision Utility Users: Members of this group are granted permission to use PI Vision Display 
Utility to migrate PI Vision displays from one server to another or change PI Server as data source. 

➔ We do not need to change the members to this group for the purpose of this training. 

 
Check SQL Server Permissions 
You can confirm that Allow Triggers to Fire Others is set to true. 
Add dbcreator and securityadmin Server Roles for student01. 
 
Create the PI Vision Database 
On the virtual environment navigate to https://PISRV01/PIVision/Admin. 

https://pisrv01/PIVision/Admin
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Allow Access to PI Servers from PI Vision 
 
On the Data Servers tab: Test Connection and check Allowed for PISRV01. 

 
 
On the Asset Servers tab: Check All for PISRV01. 
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Add a PI ProcessBook Import Folder 
Navigate to Import Folder Management and add the folder C:\ProcessBook Displays. Set a Friendly 
Name, for example ProcessBook Displays. 
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Optional: How Kerberos Delegation works 

Kerberos delegation is a network authentication protocol that allows users in a distributed application 

environment to securely access remote data sources. Kerberos delegation is designed to provide strong 

authentication for client/server applications by using secret key cryptography. Clients obtain tickets from 

the Kerberos Key Distribution Center on Domain Controller and provide these tickets to servers when 

connections are established. 

Kerberos Double Hop 

Simply speaking, to view data from PI Data Archive and PI AF in PI Vision, client’s (user’s) account must 

authenticate not only to PI Vision IIS Application Server, but also to PI Data Archive and PI AF. PI Vision 

IIS Application server needs to forward (delegate) client’s credentials to PI Data Archive and PI AF for 

authentication. This is called a Double Hop scenario. 

Kerberos Double Hop is a term used to describe our method of maintaining the client's Kerberos 

authentication credentials over two or more connections. In this fashion we can retain the user’s credentials 

and act on behalf of the user in further connections to other servers. 

It works in 5 steps: 

Step 1 – Client provides credentials to domain controller and it returns a Kerberos ticket to the client.  

Kerberos ticket confirms the client credentials are validated and client is authorized to receive a service 

ticket. Service ticket provides access to application services. 

Step 2 – Client uses the Kerberos ticket to request a service ticket from domain controller to connect to PI 

Vision IIS Application Server. 

Step 3 – Client connects to PI Vision IIS Application Server and provides both Kerberos and service tickets. 

Step 4 – PI Vision IIS Application Server uses the client’s Kerberos ticket to request a service ticket, so PI 

Vision IIS Application Server can connect to PI Data Archive / PI AF. 

Step 5 – PI Vision IIS Application Server connects to PI Data Archive / PI AF using the client’s credentials. 
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Kerberos Delegation Types 

There are four types of Kerberos delegation: 

• Unconstrained Delegation (not recommended) 

• Constrained Delegation – Kerberos Only 

• Constrained Delegation – Any Authentication Protocol 

• Resource-Based Constrained Delegation 

 

Constrained delegation is more secure because it limits delegation to a specified list of services, rather 
than allowing delegation to any service as in unconstrained delegation. It requires additional configuration 
compared with unconstrained delegation. Service Principal Names must be setup for accounts the 
services are running under. 

Kerberos only means there is no protocol transition to a non-Kerberos authentication method. 

Any Authentication Protocol allows protocol transition if Kerberos authentication fails. 

These types of delegation are configured for the service that delegates to other services. In our case, PI 
Vision service (PIVisionServiceAppPool) delegates to PI Network Manager service of PI Data Archive and 
PI AF Application Service. 

Setting up the delegation requires access to the Active Directory Users and Computers on the Domain 
Controller and Domain Admin privileges. 

Setting up Kerberos delegation is described in PI Vision Installation and Administration Guide in chapter 
“Enable Kerberos delegation using a custom PI Vision service account” or in OSIsoft Live Library.  

  

https://livelibrary.osisoft.com/LiveLibrary/content/en/vision-v3/GUID-62223D5D-CE8A-494B-88A1-6491850F4B54#addHistory=true&filename=GUID-4B33BAFA-A923-4550-B3DC-CAD83E3C0587.xml&docid=GUID-68329569-D75C-406D-AE2D-9ED512E74D46&inner_id=&tid=&query=&scope=&resource=&toc=false&eventType=lcContent.loadDocGUID-68329569-D75C-406D-AE2D-9ED512E74D46
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Resource-based Constrained Delegation (RBCD) introduced with Windows Server 2012 on the other 
hand has several benefits from the previous types: 

• Is configured for the account of the resource service (PI Network Manager, PI AF Application 
Service) instead of the account of the service that delegates (PIVisionServiceAppPool). 

• Domain Admin privileges are not required. 

• Functions across domain and forest boundaries. 

Therefore, RBCD is highly recommended type of delegation to set up. 

RBCD configuration can only be done via PowerShell. To setup the delegation for the account of the service 

we need to delegate to -PrincipalsAllowedToDelegateToAccount parameter is used.  

Setting up RBCD is described in PI Vision Installation and Administration Guide in chapter “Configure 
resource-based constrained delegation” or in OSIsoft Live Library. 

How do I set up Kerberos delegation for PI Vision? summarizes the links to the documentation explaining 
how the various delegation types are set up. 

Service Principal Name 

A service principal name (SPN) is a unique identifier of a service instance. SPNs are used by Kerberos 

authentication to associate a service instance with a service logon account. This allows a client application 

to request that the service authenticate an account even if the client does not have the account name. 

Without the SPN the client cannot receive the Service ticket and Kerberos delegation is not possible. 

To configure delegation for PI Vision the SPNs must be registered for these services: 

• PI Network Manager for PI Data Archive 

• PI AF Application Service for PI AF 

• IIS PIVisionServiceAppPool, PIVisionAdminAppPool, PIVisionUtilityAppPool application pools for 

PI Vision 

 

The SPN name format for host-based service is composed of two elements: 

<service class>/<host> 

<service class>: A string that identifies the general class of the service. For example, “SqlServer”. In 
general, this can be any string that is unique to the service class. Be aware that the SPN syntax uses a 
forward slash (/). 

• PIServer is service class of PI Network Manager service of PI Data Archive 

• AFServer is service class of PI AF Application Service 

• HTTP is service class for web applications using HTTP or HTTPS protocol such as PI Vision 

<host>: The name of the computer on which the service is running. It can be FQDN or hostname. 

SPN can be registered from any machine which is a member of the domain by user with appropriate 

permissions (such as Domain Admin or any user who was granted permissions) 

To register an SNP use command line tool SETSPN in elevated command prompt and the following syntax: 

setspn -s <service class>/<host> <domain>\<service account> 

https://livelibrary.osisoft.com/LiveLibrary/content/en/vision-v3/GUID-62223D5D-CE8A-494B-88A1-6491850F4B54#addHistory=true&filename=GUID-4B33BAFA-A923-4550-B3DC-CAD83E3C0587.xml&docid=GUID-62223D5D-CE8A-494B-88A1-6491850F4B54&inner_id=&tid=&query=&scope=&resource=&toc=false&eventType=lcContent.loadDocGUID-62223D5D-CE8A-494B-88A1-6491850F4B54
https://customers.osisoft.com/s/knowledgearticle?knowledgeArticleUrl=How-do-I-set-up-Kerberos-delegation-for-PI-Vision
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It is a good practice to register SPN for both <host> identifiers: hostname and FQDN. 

To verify the SPNs are registered correctly use SETSPN -L <domain>\<service account>. 

 

PI Data Archive and PI AF are capable to register the SPNs by themselves if their service account is 

granted the permissions using this PowerShell command: 

$gMSA = Get-ADServiceAccount -Identity SVC-PIDA 
dsacls $gMSA.DistinguishedName /G "SELF:RPWP;servicePrincipalName" 

$gMSA = Get-ADServiceAccount -Identity SVC-PIAF 
dsacls $gMSA.DistinguishedName /G "SELF:RPWP;servicePrincipalName" 

 

For more detailed information about Service Principal Names beyond the scope necessary for this course 
visit Microsoft Docs. 

 

  

https://docs.microsoft.com/en-us/windows/win32/ad/service-principal-names
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Set up Kerberos Delegation 

Video: PI Vision 2020 Installation - Phase 5 - Set up Kerberos Delegation 

 

Introduction 
 
This video demonstrates the steps to set up Kerberos delegation after installing and configuring PI Vision 
2020. It is divided into the following sections: 

1. Configure the PI Vision Website to Use the Application Pool Credentials 

2. Create HTTP Service Principal Names (SPNs) 

3. Configure Kerberos Delegation for the PI Vision Service Account 

4. Test PI Vision Access Remotely 

Part 1: Configure the PI Vision Website to Use the Application Pool Credentials 
 
To configure Kerberos delegation for PI Vision, we will first verify the PI Vision application pool account. In 
IIS Manager, click the web server then click Application Pools. Here we can verify that our three PI 
Vision application pools are running as the same domain service account. Thus, we will follow the Enable 
Kerberos delegation using a custom PI Vision service account section of the PI Vision Installation 
and Administration guide. 
 
In IIS Manager, expand sites and the site where PI Vision is installed (in my case Default Web Site), and 
click the PIVision application. Under IIS double click Authentication and verify that Windows 
Authentication is enabled. Select Windows Authentication and click Advanced Settings. In the 
Advanced Settings window, verify that Enable Kernel-mode authentication is checked. Close the 
Advanced Settings window and click Providers. Verify that the Enabled Providers are Negotiate at the 
top and NTLM below. Close the Providers window. 
 
Next, click the PIVision application and under Management double click Configuration Editor. In the 
Section field, navigate to system.webServer/security/authentication/ and select 
windowsAuthentication. Set the useAppPoolCrednentials property to True and click Apply. Finally, 
open command prompt as an administrator and run the iisreset command. 
 
Part 2: Create HTTP Service Principal Names (SPNs) 
 
The next step to configuring Kerberos is to create the HTTP service principal names (or SPN) under the 
PI Vision application pool account. To do this, you will need the Validated Write to Service Principal 
Names privilege on the user in Active Directory. Contact your IT for assistance if you do not have this 
privilege. 
 
Open command prompt as an administrator and use the setspn -s command to create an HTTP SPN for 
the netbios name of the PI Vision web server following the format shown (setspn -s HTTP/netbios-server-
name domain\service-account). After entering the command, verify no errors are returned. 
 
Next use the setspn -s command to create an HTTP SPN for the fully qualified DNS name of the PI Vision 
web server following the format shown (setspn -s HTTP/fully-qualified-DNS-name domain\service-
account). After entering the command, verify no errors are returned. 

https://www.youtube.com/watch?v=aQmh3Ov0mMQ
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To verify the SPNs are correctly registered under the PI Vision domain service account, use the setspn -l 
command following the format shown. Verify the two HTTP SPNs for the PI Vision web server are 
returned. 
 
Part 3: Configure Kerberos Delegation for the PI Vision Service Account 
 
The final step is to configure Kerberos delegation for the PI Vision service account. For this step you will 
need access to a domain controller. Contact your IT for assistance if you do not have this access. 
 
On the domain controller, open Active Directory Users and Computers. Find the PI Vision domain 
account. It may be under Users. Right click the name of the PI Vision domain account and click 
Properties. In the Properties window, click the Delegation tab and select Trust this user for delegation 
to specified services only. Under this option, select Use any authentication protocol. We recommend 
this setting for delegation as it allows users who’ve authenticated to PI Vision using NTLM to still be able 
to use Kerberos delegation. 
 
Next we will add services for each PI Data Archive that PI Vision will access. In the Delegation tab, click 
Add to open the Add Services window. Click Users or Computers. In the Select Users or Computers 
window, enter the name of the PI Data Archive. Note that if your PI Data Archive is using a custom 
service account, search for that name instead. Click Check Names then OK. In the Add Services 
window, under Available services, select PIServer and then click OK. Repeat these steps for every PI 
Data Archive that PI Vision will access. 
 
After all of the PIServer services have been added to the services list, we will add services for each AF 
Server that PI Vision will access. One note is that my AF Servers are running as a domain service 
account. Shown here in services.msc for each AF Server in the PI AF Application Service. Again, in the 
Delegation tab for the PI Vision service account, click Add to open the Add Services window. Click 
Users or Computers. In the Select Users or Computers window, I will enter the PI AF Application 
service account because that what my AF Server is running as. If your AF Server is instead running as a 
machine account, enter the AF Server machine name. Click Check Names then OK. In the Add 
Services window, under Available services, select AFServer and click OK. Repeat these steps for 
every AF Server that PI Vision will access. 
 
After all PIServer and AFServer services have been added to the services list, click Apply. 
 
Part 4: Test PI Vision Access Remotely 
 
Now that Kerberos delegation has been configured, we can test PI Vision remote access. On a client 
machine, open a web browser and enter the PI Vison site URL. By default, the PI Vision site will be 
located at https://webserver/PIVision where webserver is the name of the PI Vision web server.  
 
Once the PI Vision home page appears make sure there are no errors and the PI ProcessBook import 
folders appear under Home. Because we updated the PI Vision website to use a domain certificate, we 
don’t have any certificate errors on the client machine. Click New Display and in the new display window, 
enter a search term in the Assets pane to verify searching is working. Select a data item and drag it onto 
the display to make sure clients can see data for each PI Data Archive and AF Server. Keep in mind for 
other users to access PI Vision they will need to be in the PI Vision Users group. In addition, to see data 
they will need to have appropriate read permissions on each PI Data Archive and AF Server through 
mappings.  
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Conclusion 
With that we have a successful PI Vision installation and configuration. And users are now able to access 
data from our PI Servers remotely over the web. If you have any problems or receive any different 
behavior, note the behavior or errors you receive in PI Vision. In addition, you can check the Event Viewer 
Logs on the PI Vision web server. Open Event Viewer and expand Applications and Services Log. The 
PI Vision logs will be the four logs that start with OSIsoft. You can send this information to our product 
support team. Thanks for watching and hope you are enjoying your PI Vision installation. 

 

 

Exercise 

Perform the steps to set up Kerberos Delegation on the virtual environment.  You will need to make some 
adaptions to the setup at hand compared to the video. If you are unsure, have a look at the solution for 
guidance. 
 
Tasks: 
 

- Configure the PI Vision Website to Use the Application Pool Credentials 

- Create HTTP Service Principal Names (SPNs) 

- Configure Kerberos Delegation for the PI Vision Service Account 

- Test PI Vision Access Remotely 

Solution 

Configure the PI Vision Website to Use the Application Pool Credentials 
 
Follow steps from the video to check settings. As shown there, you will need to set 
useAppPoolCredentials to True and run an iisreset. 
 
Create HTTP Service Principal Names (SPNs) 
 
Run a command prompt (cmd) as administrator and type: 
 

setspn -s HTTP/PISRV01 pischool\PIVisionService 
 
setspn -s HTTP/PISRV01.pischool.int pischool\PIVisionService 

 
If you want to check what has been created for the user PIVisionService:  
setspn -l pischool\PIVisionService 
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Configure Kerberos Delegation for the PI Vision Service Account 
 
Open Active Directory Users and Computers on the Domain Controller. Previously, we have created 
PIVisionService as a domain user. Thus, it can be found under Users: 
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Follow instructions in the video. In contrast to what is demonstrated in the video, the PI AF Application 
Service on the virtual environment is running under a machine account. As for the Data Archive server 
before, enter machine name and select AFServer as Service Type as shown. 
 

 
 
Test PI Vision Access Remotely 
 
You can test the remote access using the DC, but since we are using the self-signed certificate there will 
be a certificate warning. You can still access PI Vision by opening up More information and clicking Go on 
to the webpage (not recommended). 
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Enabling Users to Change the Display Language 

 

The PI Vision Multilingual User Interface (MUI) is available for download from the OSIsoft Customer 
Portal. 

 

PI Vision Multilingual User Interface (MUI) support allows users to view the application in eight different 
languages: 

• French 

• German 

• Spanish 

• Polish 

• Portuguese 

• Simplified Chinese 

• Japanese 

• Korean 

• Russian 

  

https://my.osisoft.com/
https://my.osisoft.com/


60 | P a g e 
 

During the installation process you can choose to install only the languages which are relevant in your 
organization. 

 

 

 

The PI Vision MUI install kit (PIVisionMUI_2020_) is available for testing on the training environment. 

After the MUI is installed on the web server, users can change the language seen in PI Vision by 
modifying the language settings in their browser. 

How the language settings are changed will depend on the browser used. On the training environment 
you can test it out using Internet Explorer. In Internet Explorer click the Gear icon and select Internet 
Options. On the General tab click the Languages button in the Appearance section at the bottom of the 
window. In the Language Preferences window click the button Set Language Preferences to open the 
settings for Windows display languages. You can add and remove languages here. 
As an example, here the appearance of a new display in German language: 
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